
Mari Mengenal KiCad



Mari Mengenal KiCad ii

31 Oktober 2021



Mari Mengenal KiCad iii

Daftar Isi

1 Mengenal KiCad 1
1.1 Mengunduh dan Menginstal KiCad . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.2 Instalasi KiCad pada GNU/Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.3 Instalasi KiCad pada Apple OS X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.4 Instalasi KiCad pada Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1.5 Dukungan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

2 Alur Kerja KiCad 4
2.1 Alur Kerja KiCad . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

2.2 Forward Annotation dan Backward Annotation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

3 Menggambar Skematik Elektronika 7
3.1 Menggunakan Eeschema . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

3.2 Koneksi Bus di KiCad . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

4 Menggambar Layout PCB 20
4.1 Menggunakan Pcbnew . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

4.2 Membuat File Gerber . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

4.3 Menggunakan GerbView . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

4.4 Melakukan Routing Otomatis dengan FreeRouter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

5 Forward Annotation pada KiCad 31

6 Membuat Komponen Skematik di KiCad 32
6.1 Menggunakan Component Library Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

6.2 Ekspor, Impor, dan Modifikasi Komponen Library . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

6.3 Membuat Komponen Skematik dengan QuickLib . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

6.4 Membuat Komponen Skematik dengan Jumlah Pin yang Banyak . . . . . . . . . . . . . . . . . . . . . . . . . . 36

7 Membuat Footprint Komponen 39
7.1 Menggunakan Footprint Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

8 Catatan Tentang Portabilitas File Proyek KiCad 41

9 Lebih Lanjut Tentang Dokumentasi KiCad 42
9.1 Dokumentasi KiCad di Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42



Mari Mengenal KiCad iv

Panduan dasar yang ringkas untuk menguasai KiCad sebagai penunjang keberhasilan pengembangan papan PCB elektronik.

Hak Cipta

This document is Copyright © 2010-2015 by its contributors as listed below. You may distribute it and/or modify it under
the terms of either the GNU General Public License (http://www.gnu.org/licenses/gpl.html), version 3 or later, or the Creative
Commons Attribution License (http://creativecommons.org/licenses/by/3.0/), version 3.0 or later.

All trademarks within this guide belong to their legitimate owners.

Kontributor

David Jahshan, Phil Hutchinson, Fabrizio Tappero, Christina Jarron, Melroy van den Berg.

Terjemahan

Triyan W. Nugroho <triyan.wn@gmail.com>, 2017.

Saran dan komentar

Kirimkan laporan bug, saran atau versi baru ke alamat berikut:

• Tentang dokumentasi KiCad: https://github.com/KiCad/kicad-doc/issues

• Tentang perangkat lunak KiCad: https://bugs.launchpad.net/kicad

• Tentang proyek penerjemahan (i18n) KiCad: https://github.com/KiCad/kicad-i18n/issues

Tanggal publikasi

16 Mei 2015.

http://www.gnu.org/licenses/gpl.html
http://creativecommons.org/licenses/by/3.0/
mailto:triyan.wn@gmail.com
https://github.com/KiCad/kicad-doc/issues
https://bugs.launchpad.net/kicad
https://github.com/KiCad/kicad-i18n/issues


Mari Mengenal KiCad 1 / 42

Bab 1

Mengenal KiCad

KiCad adalah perangkat lunak sumber-terbuka (open-source) untuk membuat diagram skematik elektronika dan desain papan
PCB (Printed Circuit Board). KiCad terdiri dari serangkaian perangkat lunak yang masing-masing berdiri sendiri:

Nama program Keterangan Ekstensi file
KiCad Manajer proyek *.pro
Eeschema Editor skematik dan komponen *.sch, *.lib, *.net
CvPcb Pemilih footprint *.net
Pcbnew Editor papan PCB *.kicad_pcb
GerbView Penampil file Gerber Semua ekstensi gerber yang umum
Bitmap2Component Konverter gambar bitmap menjadi

komponen atau footprint
*.lib, *.kicad_mod,

*.kicad_wks
PCB Calculator Kalkulator untuk komponen, lebar

track, spasi elektrik, kode warna, dan
sebagainya

Tidak ada

Pl Editor Editor layout halaman *.kicad_wks

Catatan
Daftar ekstensi file di atas bukanlah daftar yang lengkap dan hanya menampilkan sebagian dari file-file yang didukung oleh
KiCad. Daftar di atas berguna untuk pemahaman dasar mengenai file mana yang digunakan oleh masing-masing aplikasi
KiCad.

KiCad sudah cukup matang untuk digunakan dalam pengembangan dan perawatan papan elektronika yang kompleks.

KiCad tidak memiliki batas ukuran papan PCB, dan dapat dengan mudah menangani hingga 32 layer tembaga, 14 layer teknis,
dan 4 layer pelengkap. KiCad mampu menghasilkan semua file yang dibutuhkan untuk membangun papan PCB, file Gerber
untuk photo-plotter, file drilling, file lokasi komponen, dan file-file lainnya.

Sebagai aplikasi sumber-terbuka (berlisensi GPL), KiCad adalah peralatan yang ideal bagi pengguna yang berorientasi proyek
dalam pembuatan perangkat keras elektronika dengan citarasa open-source.

Anda bisa menemukan KiCad di Internet melalui alamat berikut:

http://www.kicad.org/

1.1 Mengunduh dan Menginstal KiCad

KiCad dapat berjalan di sistem operasi GNU/Linux, Apple macOS dan Windows. Anda bisa mendapatkan instruksi dan tautan
untuk mengunduh KiCad versi terbaru di:

http://www.kicad.org/download/

http://www.kicad.org/
http://www.kicad.org/download/
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Penting
KiCad versi stabil dirilis secara periodik berdasarkan Kebijakan Rilis Stabil KiCad. Fitur-fitur baru akan ditambahkan
secara kontinu ke dalam development branch. Jika Anda ingin memanfaatkan fitur-fitur baru, dan bersedia membantu
untuk melakukan pengujian fitur-fitur tersebut, silakan mengunduh paket nightly build untuk platform Anda. Nightly build
mungkin akan membawa bug, tetapi Tim Pengembangan KiCad akan selalu berusaha untuk menjaga development
branch agar tetap dapat digunakan oleh pengguna KiCad selama pengembangan fitur baru.

1.2 Instalasi KiCad pada GNU/Linux

Rilis stabil Rilis stabil KiCad dapat ditemukan pada sebagian besar manajer paket distribusi GNU/Linux dengan nama kicad dan
kicad-doc. Jika distribusi yang Anda gunakan tidak menyediakan versi stabil yang terbaru, ikuti petunjuk instalasi versi unstable,
dan pilih serta instal versi stabil yang terbaru.

Rilis unstable (nightly development) Rilis unstable dibangun dari kode sumber yang terbaru. Terkadang rilis ini akan membawa
bug yang menyebabkan kerusakan file, menghasilkan file gerber yang salah, dan sebagainya, namun secara umum rilis ini cukup
stabil dan memiliki fitur-fitur terbaru.

Di Ubuntu, cara termudah untuk menginstal KiCad versi unstable nightly build adalah melalui PPA dan Aptitude. Ketik perintah
berikut di Terminal:

sudo add-apt-repository ppa:js-reynaud/ppa-kicad

sudo aptitude update && sudo aptitude safe-upgrade

sudo aptitude install kicad kicad-doc-en

Di Fedora, cara termudah untuk menginstal KiCad versi unstable nightly build adalah melalui copr. Untuk menginstal KiCad
melalui copr, ketik perintah berikut di copr:

sudo dnf copr enable mangelajo/kicad

sudo dnf install kicad

Sebagai alternatif, Anda juga bisa mengunduh dan menginstal KiCad versi pre-compiled, atau mengunduh kode sumber secara
langsung, kemudian melakukan kompilasi dan menginstal KiCad.

1.3 Instalasi KiCad pada Apple OS X

Rilis stabil Stable builds of KiCad for OS X can be found at: https://downloads.kicad.org/kicad/macos/explore/stable

Rilis unstable (nightly development) Rilis unstable dibangun dari kode sumber yang terbaru. Terkadang rilis ini akan membawa
bug yang menyebabkan kerusakan file, menghasilkan file gerber yang salah, dan sebagainya, namun secara umum rilis ini cukup
stabil dan memiliki fitur-fitur terbaru.

Unstable nightly development builds can be found at: https://downloads.kicad.org/kicad/macos/explore/nightlies

1.4 Instalasi KiCad pada Windows

Rilis stabil Stable builds of KiCad for Windows can be found at: https://downloads.kicad.org/kicad/windows/explore/stable

Rilis unstable (nightly development) Rilis unstable dibangun dari kode sumber yang terbaru. Terkadang rilis ini akan membawa
bug yang menyebabkan kerusakan file, menghasilkan file gerber yang salah, dan sebagainya, namun secara umum rilis ini cukup
stabil dan memiliki fitur-fitur terbaru.

For Windows you can find nightly development builds at: https://downloads.kicad.org/kicad/windows/explore/nightlies

http://ci.kicad.org/job/kicad-doxygen/ws/Documentation/doxygen/html/md_Documentation_development_stable-release-policy.html
https://downloads.kicad.org/kicad/macos/explore/stable
https://downloads.kicad.org/kicad/macos/explore/nightlies
https://downloads.kicad.org/kicad/windows/explore/stable
https://downloads.kicad.org/kicad/windows/explore/nightlies
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1.5 Dukungan

Jika Anda memiliki ide, komentar atau pertanyaan, atau jika Anda memerlukan bantuan:

• Visit the Forum

• Join users on IRC or Discord

• Lihat Tutorial

https://go.kicad.org/forum/
https://www.kicad.org/community/chat/
http://www.kicad.org/help/tutorials/
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Bab 2

Alur Kerja KiCad

KiCad memiliki beberapa kemiripan dengan perangkat lunak desain PCB lainnya, namun KiCad memiliki karakteristik tersendiri
dengan alur kerja yang menarik, dimana komponen dan footprint adalah dua hal terpisah. Alur kerja yang unik ini seringkali
menjadi subyek diskusi di forum Internet.

2.1 Alur Kerja KiCad

Alur kerja KiCad terdiri dari dua langkah utama: menggambar skematik, dan mendesain layout papan PCB. Kedua tugas tersebut
memerlukan library komponen dan footprint PCB. KiCad menyediakan berbagai komponen dan footprint, serta menyediakan
peralatan untuk membuat komponen dan footprint yang baru.

Pada gambar di bawah ini, Anda melihat sebuah flowchart yang menggambarkan alur kerja KiCad. Flowchart ini menjelaskan
langkah apa yang perlu diambil, dan bagaimana urutan langkahnya. Untuk memudahkan, disertakan pula gambar ikon yang
sesuai.
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Untuk informasi lebih mengenai pembuatan komponen, baca Membuat Komponen Skematik di KiCad. Dan untuk informasi
mengenai bagaimana cara membuat footprint, lihat Membuat Footprint Komponen.

Pada situs berikut:

http://kicad.rohrbacher.net/quicklib.php

Anda akan menemukan sebuah contoh penggunaan alat untuk membuat komponen library KiCad dengan cepat. Untuk informasi
lebih lanjut mengenai Quicklib, lihat Membuat Komponen Skematik Dengan Quicklib.

2.2 Forward Annotation dan Backward Annotation

Jika skematik telah selesai digambar, langkah berikutnya adalah mentransfer gambar tersebut menjadi PCB sesuai dengan alur
kerja KiCad. Terkadang, kita perlu menambahkan komponen baru, komponen perlu diubah ke ukuran yang berbeda, dan seba-
gainya. Hal ini dapat dilakukan dengan dua cara: Forward Annotation dan Backward Annotation.

Backward Annotation adalah suatu proses untuk mengirimkan kembali adanya perubahan layout PCB ke skematik yang sesuai.
Namun fitur ini dianggap tidak terlalu berguna.

Forward Annotation adalah proses mengirimkan informasi skematik ke layout PCB yang sesuai. Ini adalah fitur dasar kare-
na Anda tentu tidak ingin mengulangi dari awal proses pembuatan layout PCB setiap kali Anda melakukan modifikasi pada
skematik.Forward Annotation akan kita diskusikan pada bagian Forward Annotation.

http://kicad.rohrbacher.net/quicklib.php
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Bab 3

Menggambar Skematik Elektronika

Pada bagian ini, kita akan belajar bagaimana cara menggambar sebuah skematik elektronika dengan menggunakan KiCad.

3.1 Menggunakan Eeschema

1. Pada sistem operasi Windows, jalankan kicad.exe. Pada sistem operasi Linux, ketik kicad pada Terminal. Anda sekarang
berada di window utama manajer proyek KiCad. Dari sini Anda memiliki akses ke delapan buah peralatan: Eeschema,
Schematic Library Editor, Pcbnew, PCB Footprint Editor, GerbView, Bitmap2Component, PCB Calculator dan Pl Editor.
Perhatikan diagram alur kerja untuk mengetahui bagaimana kedelapan peralatan utama tersebut digunakan.

2. Buatlah sebuah proyek baru: File→ New Project→ New Project. Berilah nama file proyek Anda tutorial1. File proyek
akan secara otomatis mendapatkan ekstensi ".pro". KiCad akan menawarkan untuk membuat sebuah direktori untuk proyek
Anda, klik "Yes". Semua file proyek Anda akan disimpan di sini.

3. Mari kita mulai dengan membuat sebuah skematik. Bukalah editor skematik Eeschema, . Eeschema berada di
tombol pertama dari kiri.

4. Klik pada ikon Page Settings pada toolbar bagian atas. Aturlah ukuran kertas dengan memilih A4 dan masukkan
nama Tutorial1 pada kotak Title. Anda juga bisa menambahkan informasi yang lebih lengkap jika diperlukan. Klik OK.
Informasi ini akan mengisi sudut kanan bawah lembar skematik. Gunakan mouse wheel untuk melakukan zoom. Simpan
keseluruhan proyek skematik Anda: File→ Save Schematic Project.

5. Sekarang kita akan meletakkan komponen pertama kita. Klik pada ikon Place component pada toolbar sebelah
kanan. Anda juga bisa menekan tombol shortcut Place component (a).
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Catatan
Anda bisa melihat daftar tombol shortcut yang tersedia dengan menekan tombol ?.

6. Klik lembar skematik Anda. Sebuah window Choose Component akan muncul di layar. Kita akan meletakkan sebuah
resistor. Carilah komponen ini dengan mengetikkan R (dari Resistor) pada kotak Filter. Anda akan menemukan Resistor
yang berada di dalam grup device. device adalah nama library di mana komponen tersebut berada, yang merupakan library
yang cukup umum dan berguna.

7. Lakukan klik ganda pada R. Window Choose Component akan tertutup. Letakkan komponen pada lembar skematik dengan
melakukan klik di lokasi yang Anda inginkan.

8. Klik pada ikon kaca pembesar untuk melakukan zoom komponen. Sebagai alternatif, gunakan mouse wheel untuk mela-
kukan zoom-in atau zoom-out. Tekan mouse wheel (atau tombol tengah mouse) untuk menggeser lembar skematik secara
horisontal maupun vertikal.
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9. Cobalah untuk meletakkan mouse di atas komponen R dan tekan tombol r. Perintah tersebut akan memutar komponen.
Anda tidak perlu melakukan klik pada komponen yang akan diputar.

Catatan
Jika mouse Anda berada di atas Field Reference (R) atau Field Value (R?), akan muncul sebuah menu. Anda akan
sering menemukan menu Clarify Selection ini di KiCad; menu tersebut memungkinkan kita bekerja pada objek yang
berada di atas objek lain. Pada kasus ini, beritahu KiCad bahwa Anda ingin melakukan perintah pada Component
. . . R. . . .

10. Klik kanan pada bagian tengah komponen dan pilih Edit Component→ Value. Anda bisa mendapatkan hasil yang sama
dengan meletakkan mouse di atas komponen dan menekan tombol v. Alternatif lainnya, Anda bisa menekan tombol e
untuk masuk ke window Edit yang lebih bersifat umum. Perhatikan bagaimana menu klik kanan berikut ini menampilkan
tombol shortcut untuk semua perintah yang tersedia.

11. Window untuk mengedit value akan muncul. Ganti nilai saat ini R dengan 1 k. Klik OK.

Catatan
Jangan mengubah Reference field (R?) karena nilai ini nanti akan berubah secara otomatis. Nilai di dalam resistor
sekarang akan berubah menjadi 1 k.

12. Untuk meletakkan resistor lainnya, klik di mana Anda ingin meletakkannya. Window Component Selection akan muncul
kembali.
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13. Resistor yang tadi Anda pilih sekarang ada di dalam daftar history Anda, dan ditampilkan sebagai R. Klik OK dan letakkan
komponen tersebut.

14. Jika Anda melakukan kesalahan dan ingin menghapus sebuah komponen, klik kanan pada komponen tersebut dan klik De-
lete Component. Perintah ini akan menghapus komponen dari lembar skematik. Alternatif lainnya, Anda bisa meletakkan
mouse di atas komponen yang ingin dihapus, dan tekan tombol Del.

Catatan
Anda bisa mengubah tombol shortcut default dengan membuka Preferences → Hotkeys → Edit hotkeys. Setiap
perubahan akan segera disimpan secara otomatis.

15. Anda juga bisa menyalin sebuah komponen yang sudah ada di lembar skematik Anda, dengan cara meletakkan mouse di
atas komponen dan menekan tombol c. Klik di mana Anda ingin meletakkan salinan komponen tersebut.

16. Klik kanan pada resistor kedua. Pilih Drag Component. Atur ulang posisi dari komponen dan klik kiri untuk meletakkan-
nya. Fungsi yang sama dapat dilakukan dengan meletakkan mouse di atas komponen dan menekan tombol g. Tombol r
akan memutar komponen, serta tombol x dan y akan membalik komponen berdasarkan sumbu x atau y.



Mari Mengenal KiCad 11 / 42

Catatan
Klik kanan→ Move component atau tombol m juga dapat Anda gunakan untuk memindahkan apapun, tapi akan lebih
baik untuk digunakan hanya pada label komponen dan komponen yang belum terhubung. Kita akan akan membahasnya
nanti.

17. Edit resistor kedua dengan meletakkan mouse di atasnya dan menekan tombol v. Ganti nilai R dengan 100. Anda bisa
membatalkannya dengan menekan Ctrl+z.

18. Ubah ukuran grid. Anda mungkin sudah memperhatikan bahwa pada lembar skematik, semua komponen akan menempel
pada grid yang berukuran besar. Anda bisa dengan mudah mengubah ukuran grid dengan Klik kanan → Grid select.
Secara umum, direkomendasikan untuk menggunakan ukuran grid dengan ukuran 50.0 mils pada lembar skematik.

19. Kita akan menambahkan sebuah komponen dari library yang belum dimasukkan pada proyek default. Pada menu, pilih
Preferences→ Component Libraries dan klik tombol Add untuk menambahkan library ke kotak Component library
files.

20. Anda harus mencari lokasi library resmi KiCad yang terinstal di komputer Anda. Carilah direktori library yang
berisi ratusan file .dcm dan .lib. Lihat direktori C:\Program Files (x86)\KiCad\share\ (Windows) dan
/usr/share/kicad/library/ (Linux). Jika Anda telah menemukan direktori tersebut, pilih dan tambahkan library
microchip_pic12mcu dan tutup window.

21. Ulangi langkah penambahan komponen, namun kali ini kita tidak memilih library device. Pilihlah library microchip_pic12mcu
dan ambil komponen PIC12C508A-I/SN.

22. Letakkan mouse di atas komponen mikrokontroler. Perhatikan bahwa tombol x dan y akan membalik komponen tersebut
berdasarkan sumbu x atau y. Kembalikan komponen tersebut ke orientasi awal.

23. Ulangi langkah penambahan komponen, kali ini pilih library device dan ambil komponen LED.

24. Atur semua komponen pada lembar skematik Anda seperti di bawah ini.
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25. Sekarang kita akan membuat komponen skematik MYCONN3 untuk konektor 3-pin. Anda bisa langsung melompat ke
bagian yang berjudul Membuat Komponen Skematik di KiCad untuk belajar membuat komponen ini dari awal, kemudian
kembali ke bagian ini untuk melanjutkan latihan kita.

26. Anda bisa meletakkan komponen yang baru saja Anda buat. Tekan tombol a dan ambil komponen MYCONN3 dari library
myLib.

27. Penunjuk nama komponen J? akan muncul di bawah label MYCONN3. Jika Anda ingin mengubah posisinya, klik kanan
pada J? dan klik Move Field (atau tekan tombol m). Anda mungkin perlu melakukan zoom sebelum/sambil menjalankan
perintah ini. Gambar di bawah menunjukkan pemindahan posisi J?. Label dapat dipindahkan posisinya sesuai keinginan
Anda.
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28. Sekarang waktunya meletakkan simbol power dan ground. Klik pada tombol Place a power port pada toolbar
sebelah kanan. Anda juga bisa menekan tombol p. Pada window pemilihan komponen, scroll ke bawah dan pilih VCC dari
libray power. Klik OK.

29. Klik di atas pin resistor 1 k untuk meletakkan part VCC. Klik pada area di atas VDD pada mikrokontroler. Pada grup
history pada window Component Selection, pilih VCC dan letakkan di sebelah pin VDD. Ulangi langkah penambahan
komponen sekali lagi dan letakkan part VCC di atas pin VCC pada MYCONN3.

30. Ulangi langkah penambahan pin, namun kali ini pilih part GND. Letakkan part GND di bawah pin GND MYCONN3.
Tambahkan juga simbol GND di sebelah kanan pin VSS mikrokontroler. Lembar skematik Anda akan menjadi seperti
berikut ini:

31. Selanjutnya, kita akan menghubungkan semua komponen dengan wire. Klik pada ikon Place wire icon pada toolbar
sebelah kanan.

Catatan
Pastikan Anda tidak memilih Place a bus, yang tombolnya berada tepat di bawah tombol Place wire, namun memiliki
garis yang lebih tebal. Bagian Koneksi Bus di KiCad akan membahas mengenai penggunaan bus.

32. Klik pada lingkaran kecil di ujung pin 7 mikrokontroler, dan klik pada lingkaran kecil di ujung pin 2 LED. Anda juga bisa
melakukan zoom saat melakukan penyambungan dengan wire.



Mari Mengenal KiCad 14 / 42

Catatan
Jika Anda ingin mengubah posisi komponen yang sudah tersambung, gunakan tombol g (grab) dan jangan menggunakan
tombol m (move). Menggunakan grab akan menjaga komponen tetap tersambung dengan wire. Ulangi langkah 24 jika
Anda lupa bagaimana cara memindahkan komponen.

33. Ulangi proses ini dan hubungkan semua komponen lainnya dengan wire seperti gambar di bawah ini. Untuk mengakhiri
wire, lakukan klik ganda. Saat menghubungkan simbol VCC dan GND, wire harus menyentuh bagian bawah simbol VCC
dan bagian atas simbol GND. Lihat gambar berikut.
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34. Sekarang kita mencoba cara lain untuk membuat sambungan dengan menggunakan label. Pilih alat pemberi label dengan

klik ikon Place net name pada toolbar sebelah kanan. Anda juga bisa menekan tombol l.

35. Klik wire yang terhubung ke pin 6 mikrokontroler. Berikan nama label INPUT.

36. Lakukan langkah yang sama pada wire di sebelah kanan resistor 100 ohm. Berikan nama label INPUT pada wire tersebut.
Kedua label tersebut, karena memiliki nama yang sama, akan membuat sambungan yang tidak terlihat antara pin 6 PIC
dan resistor 100 ohm. Teknik ini akan berguna untuk menghubungkan wire pada desain yang kompleks, dimana penam-
bahan garis wire akan membuat skematik menjadi terlihat berantakan. Untuk meletakkan sebuah label, Anda tidak harus
menggambar wire, Anda juga bisa memberikan label pada sebuah pin.

37. Label juga bisa digunakan untuk sekedar memberi nama pada wire sebagai keterangan untuk wire tersebut. Letakkan
sebuah label pada pin 7 PIC. Masukkan nama uCtoLED. Berikan nama LEDtoR untuk wire yang menghubungkan resistor
dan LED, dan berikan nama INPUTtoR untuk wire yang menghubungkan MYCONN3 dan resistor.

38. Anda tidak perlu memberikan label pada jalur VCC dan GND karena label pada jalur tersebut sudah terwakili oleh obyek
dimana jalur tersebut terhubung.

39. Di bawah ini, Anda bisa melihat bagaimana seharusnya hasil akhir proyek kita.

40. Mari kita lanjutkan dengan wire yang belum terhubung. Setiap pin atau wire yang tidak terhubung akan menghasilkan
peringatan ketika dilakukan pemeriksaan oleh KiCad. Untuk meghindari peringatan tersebut, Anda bisa memberi informasi
kepada program bahwa Anda sengaja membiarkan wire tidak terhubung, atau menandai secara manual setiap pin atau wire
yang belum terhubung.
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41. Klik pada ikon Place no connect flag pada toolbar sebelah kanan. Klik pada pin 2, 3, 4, dan 5. Akan muncul tanda
X yang menunjukkan bahwa tidak adanya koneksi wire adalah disengaja.

42. Beberapa komponen memiliki pin power yang tidak terlihat. Anda dapat memunculkan pin tersebut dengan klik ikon

Show hidden pins pada toolbar sebelah kiri. Pin power yang tersembunyi akan terhubung secara otomatis jika Anda
menggunakan penamaan VCC dan GND. Secara umum, Anda sebaiknya tidak membuat pin power yang tersembunyi.

43. Sekarang kita perlu menambahkan sebuah Power Flag yang akan memberitahu KiCad bahwa ada suatu catu daya ke
rangkaian yang kita buat. Tekan tombol a, pilih List All, klik ganda pada library power dan cari PWR_FLAG. Letakkan
dua buah PWR_FLAG pada skematik. Hubungkan ke pin GND dan VCC seperti ditunjukkan pada gambar di bawah ini.

Catatan
Langkah di atas akan menghindarkan kita dari pesan peringatan pada saat pemeriksaan skematik: Warning Pin power_in
not driven (Net xx)

44. Terkadang kita perlu menambahkan komentar di sana-sini. Untuk menambahkan komentar pada skematik, gunakan ikon

Place graphic text (comment) pada toolbar sebelah kanan.

45. Semua komponen perlu memiliki penamaan yang unik. Saat ini beberapa komponen kita masih memiliki nama R? atau J?.

Pemberian nama dapat dilakukan secara otomatis dengan klik ikon Annotate schematic pada toolbar bagian atas.
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46. Pada window Annotate Schematic, pilih Use the entire schematic dan klik pada tombol Annotation. Klik OK pada pesan
konfirmasi, dan klik Close. Perhatikan bahwa semua tanda ? telah berganti dengan nomor. Sekarang setiap komponen
telah memiliki penamaan yang unik. Pada contoh kita, setiap komponen telah memiliki nama R1, R2, U1, D1 dan J1.

47. Sekarang kita akan memeriksa apakah ada kesalahan pada skematik kita. Klik pada ikon Perform electrical rules check

pada toolbar bagian atas. Klik tombol Run. Akan tampil sebuah laporan yang akan menginformasikan setiap
kesalahan atau peringatan seperti wire yang belum terhubung. Anda harus memiliki 0 Error dan 0 Warning. Jika terdapat
pesan kesalahan atau peringatan, sebuah tanda panah kecil berwarna hijau akan tampil di skematik pada posisi di mana
kesalahan atau peringatan tersebut berada. Berilah tanda centang pada Create ERC file report dan tekan tombol Run sekali
lagi untuk mendapatkan informasi yang lebih lengkap mengenai kesalahan tersebut.

Catatan
Jika Anda menemukan peringatan "No default editor found you must choose it", cobalah mengubah path ke
c:\windows\notepad.exe (Windows) atau /usr/bin/gedit (Linux).

48. Kita sudah menyelesaikan pembuatan skematik. Sekarang kita bisa membuat file Netlist dimana kita akan menambahkan

footprint untuk tiap-tiap komponen. Klik pada ikon Generate netlist pada toolbar bagian atas. Klik pada tombol
Generate dan simpan dengan nama file default.

49. Setelah membuat file Netlist, klik ikon Run Cvpcb pada toolbar bagian atas. Abaikan dan klik OK jika muncul
window pesan kesalahan mengenai adanya file yang tidak tersedia.

50. Cvpcb akan menghubungkan semua komponen yang ada di skematik Anda dengan footprint pada library KiCad. Kolom
di bagian tengah menunjukkan semua komponen yang digunakan di skematik. Pilih D1. Pada kolom di sebelah kanan,
terdapat semua footprint yang tersedia. Scroll turun dan klik ganda LEDs:LED-5MM.

51. Bisa jadi kolom di sebelah kanan hanya menampilkan beberapa pilihan footprint saja. Hal ini karena KiCad mencoba

untuk memberikan saran pemilihan footprint yang sesuai dengan komponen yang Anda gunakan. Klik pada ikon ,

dan untuk mengaktifkan dan menonaktifkan filter tersebut.

52. Untuk IC1 pilih footprint Housings_DIP:DIP-8_W7.62mm. Untuk J1 pilih footprint Connect:Banana_Jack_3Pin. Untuk
R1 dan R2 pilih footprint Discret:R1.

53. Jika Anda tertarik untuk mengetahui bentuk dari footprint yang Anda pilih, Anda bisa melakukannya dalam dua cara.

Anda bisa klik ikon View selected footprint untuk melihat tampilan footprint yang dipilih. Alternatif lainnya,

klik pada ikon Display footprint list documentation untuk menampilkan dokumen PDF dengan semua footprint
yang tersedia. Anda bisa mencetak dokumen tersebut, dan memeriksa komponen yang Anda gunakan untuk memastikan
ukurannya sesuai dengan footprint yang Anda pilih.

54. Anda telah selesai. Sekarang Anda bisa memperbarui file netlist dengan keseluruhan footprint yang sesuai dengan kom-
ponen Anda. Klik File → Save As. Anda bisa menggunakan nama default tutorial1.net. Klik Save. Anda juga bisa

menggunakan ikon . File netlist Anda sekarang telah diperbarui dengan keseluruhan footprint. Ingat bahwa jika
Anda tidak menemukan footprint untuk komponen yang Anda gunakan, maka Anda perlu membuat sendiri footprint untuk
komponen tersebut. Hal ini akan dijelaskan pada bagian lain dokumen ini.

55. Anda bisa menutup Cvpcb dan kembali ke editor skematik Eeschema. Simpan proyek Anda dengan klik File → Save
Whole Schematic Project. Tutuplah window editor skematik.
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56. Berpindahlah ke manajer proyek KiCad.

57. File netlist menjelaskan semua komponen dan koneksi pinnya. File netlist sebenarnya adalah file teks yang dapat dengan
mudah dilihat, diedit, atau dimanipulasi dengan bantuan skrip.

Catatan
File library (*.lib) juga sebenarnya merupakan file teks yang mudah untuk diedit dan dimanipulasi dengan bantuan skrip.

58. Untuk membuat daftar bahan (Bill Of Materials / BOM), bukalah editor skematik Eeschema dan klik pada ikon Bill of

materials pada toolbar bagian atas. Secara default, tidak ada plugin yang aktif. Tambahkan plugin dengan klik
tombol Add Plugin. Pilih file *.xsl yang akan Anda gunakan. Pada latihan ini, kita pilih bom2csv.xsl.

Catatan
File *.xsl berada di direktori plugins pada instalasi KiCad, yaitu: /usr/lib/kicad/plugins/.
Atau dapatkan file tersebut melalui:

wget https://raw.githubusercontent.com/KiCad/kicad-source-mirror/master/eeschema/ ←↩
plugins/bom2csv.xsl

KiCad akan membuat perintah secara otomatis, sebagai contoh:

xsltproc -o "%O" "/home/<user>/kicad/eeschema/plugins/bom2csv.xsl" "%I"

Anda mungkin ingin menambahkan ekstensi, maka ubahlah perintah ini menjadi:

xsltproc -o "%O.csv" "/home/<user>/kicad/eeschema/plugins/bom2csv.xsl" "%I"

Tekan tombol Help untuk informasi lebih lanjut.

59. Sekarang tekan Generate. Hasilnya berupa file (dengan nama sama dengan proyek Anda) yang disimpan di dalam folder
proyek Anda. Buka file *.csv dengan LibreOffice Calc atau Excel. Akan tampil sebuah window impor, tekan OK.

Anda sekarang siap untuk melanjutkan langkah ke pembuatan layout PCB, yang akan kita bahas pada bagian berikutnya. Namun
sebelum kita lanjutkan, marilah kita lihat bagaimana cara menghubungkan pin-pin komponen menggunakan jalur bus.

3.2 Koneksi Bus di KiCad

Kadang kala Anda mungkin ingin menghubungkan pin-pin sekuensial pada komponen A dengan pin-pin sekuensial pada kompo-
nen B. Pada kasus ini, Anda memiliki dua opsi: menggunakan metode pelabelan seperti yang sudah kita praktekkan sebelumnya,
atau menggunakan koneksi bus. Mari kita lihat bagaimana cara melakukannya.

1. Misalkan Anda memiliki tiga buah konektor 4-pin yang ingin Anda hubungkan secara bersama-sama dari pin ke pin.
Gunakan pelabelan (tekan tombol l) untuk memberi label pin 4 dari part P4. Beri nama label a1. Sekarang tekan tombol
Ins agar label ini ditambahkan secara otomatis ke pin di bawah pin 4 (PIN 3). Perhatikan bahwa label akan secara otomatis
diberi nama a2.

2. Tekan tombol Ins dua kali lagi. Tombol ini adalah shortcut untuk perintah Repeat last item dan ini adalah perintah yang
sangat berguna yang akan memudahkan pekerjaan Anda.
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3. Ulangi langkah pelabelan yang sama pada dua konektor yang lain, yaitu CONN_2 dan CONN_3, dan Anda telah selesai.
Jika Anda melanjutkan dan membuat PCB, Anda akan melihat bahwa ketiga konektor saling terhubung satu sama lain.
Gambar 2 menampilkan hasil dari apa yang kita bahas ini. Agar tampak lebih menarik, kita juga bisa menambahkan

serangkaian Place wire to bus entry menggunakan ikon dan jalur bus menggunakan ikon , seperti ditunjukkan
pada Gambar 3. Namun perlu diingat bahwa hal ini tidak akan memberi efek apapun pada PCB.

4. Anda juga perlu tahu bahwa wire pendek yang terhubung ke pin-pin pada Gambar 2 bukanlah suatu keharusan. Pada
kenyataannya, kita juga bisa melabeli pin-pin tersebut secara langsung, tanpa harus menggunakan wire.

5. Mari kita menuju langkah selanjutnya. Misalkan Anda memiliki konektor keempat dengan nama CONN_4, dan entah
mengapa, pelabelannya sedikit berbeda dengan konektor lainnya (b1, b2, b3, b4). Sekarang kita ingin menghubungkan
dari pin ke pin antara Bus a dengan Bus b. Kita ingin melakukannya tanpa menggunakan pelabelan pin (walaupun hal itu
dimungkinkan untuk dilakukan), namun kita akan menggunakan pelabelan pada jalur bus, dengan satu label per bus.

6. Hubungkan dan beri label CONN_4 menggunakan metode pelabelan seperti yang dijelaskan sebelumnya. Beri nama

pin b1, b2, b3, dan b4. Hubungkan pin ke serangkaian Wire to bus entry menggunakan ikon dan ke jalur bus

menggunakan ikon . Lihat Gambar 4.

7. Berikan label (tekan tombol l) pada bus CONN_4 dan namai dengan b[1..4].

8. Berikan label (tekan tomol l) pada bus a sebelumnya dan namai dengan a[1..4].

9. Apa yang bisa kita lakukan sekarang adalah menghubungkan bus a[1..4] dengan bus b[1..4] menggunakan jalur bus dengan

tombol .

10. Dengan menghubungkan kedua bus tersebut, pin a1 akan secara otomatis terhubung ke pin b1, a2 akan terhubung ke b2
dan seterusnya. Gambar 4 menunjukkan tampilan hasil akhirnya.

Catatan
Opsi Repeat last item yang dapat diakses melalui tombol Ins dapat digunakan untuk mengulangi penambahan item.
Sebagai contoh, wire pendek yang terhubung pada semua pin di Gambar 2, Gambar 3 dan Gambar 4, ditambahkan
dengan menggunakan opsi ini.

11. Opsi Repeat last item yang dapat diakses melalui tombol Ins juga dapat digunakan untuk meletakkan beberapa rangkaian

Wire to bus entry dengan menggunakan ikon .
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Bab 4

Menggambar Layout PCB

Sekarang tiba waktunya kita gunakan file netlist untuk membuat layout PCB. Alat yang kita gunakan adalah Pcbnew.

4.1 Menggunakan Pcbnew

1. Dari halaman manajer proyek KiCad, klik pada ikon Pcbnew . Window Pcbnew akan terbuka. Jika Anda menda-
patkan pesan kesalahan bahwa file *.kicad_pcb tidak ditemukan dan meminta Anda untuk membuatnya, klik Yes.

2. Mulailah dengan memasukkan beberapa informasi skematik. Klik pada ikon Page settings pada toolbar bagian atas.
Atur ukuran kertas dan pilih A4, dan masukkan judul Tutorial1.

3. Sebaiknya kita mulai dengan mengatur clearance dan minimum track width sesuai dengan yang dibutuhkan oleh ma-
nufaktur PCB yang akan Anda gunakan. Secara umum Anda dapat mengatur clearance 0.25 dan lebar minimum track
0.25. Klik menu Design Rules→ Design Rules. Klik tab Net Classes Editor jika tab tersebut belum tampil. Ubah nilai
Clearance pada bagian atas window menjadi 0.25 dan nilai Track Width menjadi 0.25 seperti ditunjukkan pada gambar di
bawah ini. Satuan untuk ukuran di sini adalah mm.

4. Klik pada tab Global Design Rules dan atur Min track width menjadi 0.25. Klik tombol OK untuk menyimpan perubahan
Anda, dan tutup window Design Rules Editor.

5. Sekarang kita akan mengimpor file netlist. Klik pada ikon Read Netlist pada toolbar bagian atas. Klik pada tombol
Browse Netlist Files, pilih tutorial1,net pada dialog pemilihan file, dan klik pada Read Current Netlist. Lalu klik tombol
Close.
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6. Semua komponen akan tampak pada sudut kiri atas, tepat di atas halaman. Lakukan scroll ke atas jika Anda tidak bisa
melihatnya.

7. Pilih semua komponen dengan mouse, dan pindahkan ke tengah lembar kerja. Jika diperlukan, Anda bisa melakukan zoom
sembari memindahkan komponen.

8. Semua komponen terhubung melalui sekelompok wire tipis yang disebut ratsnest. Pastikan bahwa tombol Hide board

ratsnest ditekan. Dengan cara ini, Anda bisa melihat ratsnest menghubungkan semua komponen.

Catatan
Keterangan pada tool-tip terbalik; menekan tombol ini akan menampilkan rastnest.

9. Anda bisa memindahkan setiap komponen dengan meletakkan mouse di atas komponen tersebut dan tekan tombol g. Klik
di mana Anda ingin meletakkannya. Pindahkan semua komponen sehingga hanya ada sedikit wire yang bersilangan.

Catatan
Jika Anda tidak menggunakan tombol g, tetapi menggunakan tombol m untuk memindahkan komponen, Anda akan
menemukan bahwa sambungan antar komponen akan terputus (hal tersebut juga akan terjadi pada editor skematik).
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10. Jika ratsnest hilang atau layar menjadi berantakan, klik kanan dan klik Redraw view. Perhatikan bahwa pin pada resistor
100 ohm terhubung dengan pin 6 pada komponen PIC. Ini adalah hasil dari metode pelabelan yang digunakan untuk
menghubungkan pin. Terkadang penggunaan label lebih disukai daripada wire karena pelabelan akan membuat skematik
menjadi lebih rapi.

11. Sekarang kita akan mendefinisikan sisi tepi dari PCB. Pilih layer Edge.Cuts dari menu drop-down pada toolbar bagian

atas. Klik pada ikon Add graphic line or polygon pada toolbar sebelah kanan. Tandai dengan mengitari sisi-sisi
tepi papan PCB, klik pada setiap sudutnya, dan ingat untuk menambahkan sedikit celah antara garis hijau dengan sisi tepi
PCB.

12. Selanjutnya, hubungkan semua wire kecuali GND, karena kita akan menghubungkan semua koneksi GND secara bersa-
maan dengan menggunaan ground plane pada pada layer tembaga bagian bawah (disebut B.Cu) pada papan PCB.

13. Sekarang kita harus memilih layer tembaga yang akan kita kerjakan. Pilih F.Cu (PgUp) pada menu drop-down pada toolbar
bagian atas. Layer ini adalah layer tembaga bagian atas.

14. Jika Anda memutuskan, misalnya, untuk menggunakan 4 layer PCB, buka Design Rules→ Layers Setup dan ubah nilai
Copper Layers menjadi 4. Pada tabel Layers Anda bisa menamai setiap layer dan menentukan apa kegunaan dari layer
tersebut. Ingat bahwa sudah disediakan beberapa preset yang berguna, yang dapat dipilih melalui menu Preset Layer
Groupings.
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15. Klik pada ikon Add Tracks and vias pada toolbar sebelah kanan. Klik pada pin 1 komponen J1 dan tarik sebuah track
ke pad R2. Klik-ganda untuk mengakhiri track tersebut. Lebar track ini secara default 0.250 mm. Anda bisa mengubah
lebar track melalui menu drop-down pada toolbar bagian atas. Secara default, Anda hanya memiliki satu pilihan ukuran
lebar track yang disediakan.

16. Jika Anda ingin menambahkan pilihan ukuran lebar track, buka: Design Rules → Design Rules → tab Global Design
Rules dan pada bagian bawah kanan window ini, tambahkan pilihan ukuran lebar track yang Anda inginkan. Anda kemu-
dian bisa memilih ukuran lebar track ini dari menu drop-down saat membuat layout PCB. Lihat contoh di bawah ini (dalam
satuan inchi).
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17. Alternatif lainnya, Anda bisa menambahkan Net Class dimana Anda bisa menentukan sejumlah opsi. Buka Design Rules
→ Design Rules→ Net Classes Editor dan tambahkan sebuah class baru dengan nama power. Ubah lebar track dari 8
mil (0.0080) ke 24 mil (0.0240). Lalu, tambahkan semuanya kecuali ground ke class power (pilih default di sebelah kiri
dan power di sebelah kanan, dan klik tombol panah).

18. Jika Anda ingin mengubah ukuran grid, lakukan Klik kanan→ Grid Select. Pastikan memilih ukuran grid yang sesuai
sebelum atau sesudah mengatur tata letak komponen dan menghubungkannya satu sama lain dengan track.

19. Ulangi proses ini sampai semua wire tersambung, kecuali pin 3 komponen J1. Papan PCB Anda akan terlihat seperti
contoh di bawah ini.
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20. Sekarang mari kita buat track pada layer tembaga sisi yang lain dari PCB. Pilih B.Cu pada menu drop-down di toolbar

bagian atas. Klik pada ikon Add tracks and vias . Gambarlah sebuah track antara pin 3 komponen J1 dan pin
8 komponen U1. Hal ini sebenarnya tidak diperlukan karena kita bisa melakukannya dengan ground plane. Perhatikan
bagaimana warna track yang akan kita gambar telah berubah.

21. Membuat track dari pin A ke pin B dengan berpindah layer. Dimungkinkan untuk berpindah ke layer tembaga yang
lain saat Anda membuat track, melalui perantaraan via. Saat membuat track pada layer tembaga bagian atas, klik kan-
an dan pilih Place Via atau tekan tombol v. Anda akan berpindah ke layer tembaga bagian bawah di mana Anda bisa
menyelesaikan track yang sedang dibuat.
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22. Apabila Anda ingin memeriksa suatu jalur atau sambungan, klik pada ikon Net highlight icon pada toolbar sebelah
kanan. Klik pada pin 3 komponen J1. Track dan semua pad yang terhubung ke pin tersebut akan di-highlight.

23. Sekarang kita akan membuat sebuah ground plane yang akan terhubung ke semua pin GND. Klik pada ikon Add Zones

pada toolbar sebelah kanan. Kita akan membuat sebuah persegi yang melingkupi keseluruhan papan PCB kita,
maka klik di lokasi salah satu sudut yang Anda inginkan. Pada kotak dialog yang muncul, atur Pad in Zone ke Thermal
relief dan Zone edges orient ke H,V dan klik OK.

24. Tandai dengan mengitari garis luar papan PCB dengan klik pada setiap sudut secara melingkar. Klik-ganda untuk menye-
lesaikan persegi yang Anda buat. Klik kanan di dalam area persegi yang telah Anda buat, dan klik pada Fill or Refill All
Zones. Papan PCB kita akan terisi dengan warna hijau seperti gambar berikut:
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25. Jalankan Design Rule Check dengan klik ikon Perform Design Rules Check pada toolbar bagian atas. Klik tombol
Start DRC. Pastikan tidak ada pesan kesalahan yang muncul. Klik pada List Unconnected. Pastikan tidak ada track yang
belum terhubung. Klik OK untuk menutup kotak dialog DRC.

26. Simpan file Anda dengan klik File→ Save. Untuk melihat hasil akhir PCB Anda dalam bentuk 3 dimensi, klik View→
3D Viewer.
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27. Seret (drag) mouse Anda untuk memutar PCB.

28. Desain papan PCB Anda telah selesai. Untuk mengirimkannya ke manufaktur, Anda perlu membuat file Gerber.

4.2 Membuat File Gerber

Setelah PCB Anda selesai, Anda bisa membuat file Gerber untuk tiap layer dan mengirimkannya ke manufaktur PCB yang akan
memproduksi papan PCB Anda.

1. Dari KiCad, buka Pcbnew dan buka file PCB Anda dengan klik pada ikon .

2. Klik pada File→ Plot. Pilih Gerber pada Plot Format dan pilih folder dimana Anda akan menyimpan seluruh file Gerber.
Lanjutkan dengan klik pada tombol Plot.

3. Berikut adalah layer yang harus Anda pilih untuk membuat PCB 2-layer secara umum:

Layer Nama Layer KiCad Nama Layer KiCad
Versi Lama

Eksetensi Default
Gerber

"Use Protel filename
extensions" aktif

Layer Bawah B.Cu Copper .GBR .GBL
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Layer Nama Layer KiCad Nama Layer KiCad
Versi Lama

Eksetensi Default
Gerber

"Use Protel filename
extensions" aktif

Layer Atas F.Cu Component .GBR .GTL
Overlay Atas F.SilkS SilkS_Cmp .GBR .GTO
Solder Resist Bawah B.Mask Mask_Cop .GBR .GBS
Solder Resist Atas F.Mask Mask_Cmp .GBR .GTS
Sudut-sudut PCB Edge.Cuts Edges_Pcb .GBR .GM1

4.3 Menggunakan GerbView

1. Untuk melihat semua file Gerber Anda, buka manajer proyek KiCad dan klik pada ikon GerbView. Pada menu drop-down,

pilih Layer 1. Klik File → Load Gerber file atau klik pada ikon . Buka semua file Gerber Anda satu per satu.
Perhatikan bagaimana masing-masing file ditampilkan di atas file lainnya.

2. Gunakan menu di sebelah kanan untuk memilih layer yang ingin ditampilkan. Periksa dengan teliti setiap layer sebelum
mengirimkannya ke manufaktur untuk diproduksi.

3. Untuk membuat file drill, dari Pcbnew bukalah File→ Plot. Gunakan pengaturan default.

4.4 Melakukan Routing Otomatis dengan FreeRouter

Melakukan routing sebuah PCB secara manual bisa Anda lakukan dengan cepat dan menyenangkan, namun untuk PCB yang
memiliki banyak komponen, Anda mungkin ingin menggunakan autorouter. Ingat bahwa Anda harus terlebih dahulu melakukan
routing jalur-jalur yang penting secara manual, baru kemudian melanjutkan sisanya dengan autorouter. Autorouter hanya akan
mengerjakan jalur-jalur yang belum di-routing. Autorouter yang akan kita gunakan di sini adalah FreeRouter dari freerouting.net.

Catatan
Freerouter adalah aplikasi java sumber-terbuka, dan harus Anda bangun sendiri agar bisa digunakan dengan KiCad. Kode
sumber Freerouter bisa didapatkan di: https://github.com/nikropht/FreeRouting

1. Dari Pcbnew, klik File→ Export→ Specctra DSN atau klik Tools→ FreeRoute→ Export a Specctra Design (*.dsn)
file dan simpan file secara lokal. Jalankan FreeRouter dan klik pada tombol Open Your Own Design, buka file dsn Anda.

Catatan
Kotak dialog Tools→ FreeRoute menyediakan tombol help yang akan membuka dokumen berjudul Freerouter Guide-
lines. Ikutilah petunjuknya untuk menggunakan FreeRoute secara efektif.

2. FreeRouter memiliki beberapa fitur yang tidak dimiliki oleh KiCad, baik untuk routing secara manual maupun otomatis.
FreeRouter bekerja dengan dua langkah utama: pertama, melakukan routing PCB, dan kemudian melakukan optimasi.
Optimasi penuh bisa membutuhkan waktu yang lama, namun Anda bisa menghentikan prosesnya jika diperlukan.

3. Anda bisa memulai proses autorouting dengan klik pada tombol Autorouter pada toolbar bagian atas. Toolbar bagian
bawah menampilkan informasi mengenai proses routing yang sedang berjalan. Jika jumlah Pass sudah di atas 30, papan
PCB Anda mungkin tidak bisa di-autorouting dengan router ini. Sebarlah komponen Anda dan atur jaraknya, atau putarlah
beberapa komponen dan cobalah kembali melakukan autorouting. Tujuan dari memutar dan memindahkan komponen
adalah untuk mengurangi jumlah jalur yang saling bersilang pada ratsnest.

4. Klik kiri pada mouse akan menghentikan autorouting dan secara otomatis akan memulai proses optimasi. Klik kiri beri-
kutnya akan menghentikan proses optimasi. Anda sebaiknya menunggu agar FreeRouter menyelesaikan tugasnya, kecuali
Anda benar-benar perlu untuk menghentikan prosesnya.

https://github.com/nikropht/FreeRouting
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5. Klik menu File → Export Specctra Session File dan simpan file papan PCB dengan ekstensi .ses. Anda tidak perlu
menyimpan file rules FreeRouter.

6. Kembali ke Pcbnew. Anda bisa mengimpor papan PCB yang telah di-routing dengan klik pada Tools→ FreeRoute dan
kemudian klik ikon Back Import the Spectra Session (.ses) File, kemudian pilih file .ses Anda.

Jika ada jalur routing yang tidak Anda sukai, Anda bisa menghapusnya dan melakukan routing ulang. Gunakan tombol Del untuk

menghapus, dan lakukan routing ulang menggunakan ikon Add tracks pada toolbar sebelah kanan.
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Bab 5

Forward Annotation pada KiCad

Jika Anda telah menyelesaikan pembuatan skematik, footprint, layout papan PCB, dan file Gerber, maka Anda telah siap untuk
mengirimkan semua file ke manufaktur PCB untuk mewujudkan papan PCB Anda.

Alur kerja yang linier ini terkadang tidak selalu bisa searah. Sebagai contoh, ketika Anda harus memodifikasi / mengubah ukuran
papan PCB setelah Anda atau orang lain menyelesaikan alur kerja ini, mungkin Anda perlu memindahkan beberapa komponen,
menggantinya dengan komponen yang lain, mengubah footprint, dan sebagainya. Selama proses modifikasi ini, apa yang tidak
Anda inginkan adalah melakukan routing ulang dari awal untuk keseluruhan papan PCB. Yang perlu Anda lakukan adalah:

1. Kita asumsikan bahwa Anda ingin mengubah suatu konektor CON1 menjadi CON2.

2. Anda telah memiliki sebuah skematik yang lengkap dan PCB yang telah di-routing.

3. Dari KiCad, buka Eeschema, lakukan modifikasi dengan menghapus komponen CON1 dan menambahkan CON2. Simpan

proyek skematik Anda dengan ikon dan clik pada ikon Netlist generation pada toolbar bagian atas.

4. Klik pada Netlist dan kemudian save. Simpan dengan nama file default. Anda akan menimpa file yang lama.

5. Sekarang pilih footprint untuk komponen CON2. Klik pada ikon Run Cvpcb pada toolbar bagian atas. Pilih footprint
untuk komponen CON2. Komponen yang lain masih menggunakan footprint yang lama. Tutup Cvpcb.

6. Kembali ke editor skematik, simpan proyek Anda dengan klik File→ Save Whole Schematic Project. Tutup editor skema-
tik.

7. Dari manajer proyek KiCad klik pada ikon Pcbnew. Window Pcbnew akan terbuka.

8. Papan PCB yang lama, yang sudah di-routing, akan terbuka. Sekarang kita lakukan impor file netlist yang baru. Klik pada

ikon Read Netlist pada toolbar bagian atas.

9. Klik pada tombol Browse Netlist Files, pilih file netlist pada kotak dialog pemilihan file, dan klik Read Current Netlist.
Kemudian klik tombol Close.

10. Anda bisa melihat layout dengan semua komponen sebelumnya yang telah di-routing. Pada sudut kiri atas, Anda bisa
melihat semua komponen yang belum di-routing, yang dalam latihan kita adalah komponen CON2. Pilih CON2 dengan
mouse. Pindahkan komponen ke tengah papan PCB.

11. Letakkan CON2 dan lakukan routing. Jika sudah selesai, simpan dan lanjutkan dengan pembuatan file Gerber seperti biasa.

Proses yang dijelaskan di sini dapat dengan mudah diulang sebanyak yang Anda butuhkan. Di samping metode Forward Anno-
tation seperti yang dijelaskan di atas, ada juga metode yang disebut dengan Backward Annotation. Dengan metode ini, Anda
bisa membuat modifikasi pada papan PCB yang telah di-routing melalui Pcbnew, dan melakukan update hasil modifikasi tersebut
pada file skematik dan netlist. Akan tetapi metode Backward Annotation ini agak sukar digunakan, sehingga tidak dijelaskan di
sini.
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Bab 6

Membuat Komponen Skematik di KiCad

Terkadang sebuah komponen skematik yang Anda inginkan tidak tersedia di library KiCad. Ini adalah hal yang biasa terjadi,
sehingga Anda tidak perlu khawatir. Pada bagian ini, kita akan melihat bagaimana komponen skematik dapat dibuat dengan cepat
di KiCad. Meskipun demikian, perlu diingat bahwa Anda juga bisa mencari komponen KiCad di Internet, misalnya di alamat
berikut:

http://per.launay.free.fr/kicad/kicad_php/composant.php

Di KiCad, sebuah komponen tersusun dari teks yang dimulai dengan DEF dan diakhiri dengan ENDDEF. Satu atau lebih kom-
ponen umumnya disimpan di sebuah file library dengan ekstensi .lib. Jika Anda ingin menambahkan komponen ke sebuah file
library, Anda bisa dengan mudah menggunakan perintah cut dan paste.

6.1 Menggunakan Component Library Editor

1. Kita bisa menggunakan Component Library Editor (bagian dari Eeschema) untuk membuat komponen baru. Di dalam
folder proyek kita, yakni tutorial1, kita akan membuat sebuah folder bernama library. Di dalamnya kita akan menyimpan
file library kita, yaitu myLib.lib, setelah kita selesai membuat komponen yang baru.

2. Sekarang kita bisa mulai membuat komponen baru. Dari KiCad, buka Eeschema, klik pada ikon Library Editor

dan klik pada ikon New component . Window Component Properties akan muncul. Beri nama komponen yang
baru MYCONN3, ketik J pada Default reference designator, dan ketik 1 pada Number of parts per package. Klik OK.
Jika muncul pesan peringatan, klik yes. Saat ini komponen yang kita buat baru mempunyai label. Mari kita tambahkan

beberapa pin. Klik pada ikon Add Pins pada toolbar sebelah kanan. Untuk meletakkan pin, klik kiri di tengah
halaman part editor, tepat di bawah label MYCONN3.

3. Pada window Pin Properties, berikan nama pin VCC, ubah nomor pin menjadi 1, dan Electrical type menjadi Passive,
kemudian klik OK.

http://per.launay.free.fr/kicad/kicad_php/composant.php


Mari Mengenal KiCad 33 / 42

4. Letakkan pin dengan klik pada lokasi yang Anda inginkan, tepat di bawah label MYCONN3.

5. Ulangi langkah peletakan pin, namun kali ini ubah Pin name menjadi INPUT, Pin number menjadi 2, dan Electrical Type
diisi Passive.

6. angi langkah peletakan pin, namun kali ini Pin name diisi GND, Pin number diisi 3, dan Electrical Type diisi Passive. Atur
peletakan pin sehingga berurutan dari atas ke bawah. Label komponen MYCONN3 harus berada di tengah halaman (pada
pertemuan garis biru).

7. Sekarang, gambarlah garis luar komponen. Klik pada ikon Add rectangle . Kita ingin menggambar sebuah persegi
tepat di samping pin-pin kita, seperti ditunjukkan pada gambar di bawah ini. Klik di mana Anda ingin meletakkan sudut
kiri atas persegi (jangan menahan tombol mouse). Klik lagi di mana Anda ingin meletakkan sudut kanan bawah persegi.
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8. Jika Anda ingin mengisi persegi dengan warna kuning, atur nilai fill colour menjadi yellow 4 pada Preferences→ Select
color scheme, lalu pilih persegi pada layar editor dan editlah (E), pilih Fill background.

9. Simpan komponen ke dalam library Anda, myLib.lib. Klik pada ikon New Libray , buka folder tutorial1/library/
dan simpan file library yang baru dengan nama file myLib.lib.

10. Buka Preferences → Component Libraries dan tambahkan tutorial1/library/ ke dalam User defined search path dan
myLib.lib ke dalam Component library files.

11. Klik pada ikon Select working library . Pada window Select Library, klik myLib dan klik OK. Perhatikan pada judul
window yang mengindikasikan library yang sedang digunakan, yaitu myLib.

12. Klik pada ikon Update current component in current library pada toolbar bagian atas. Simpan semua perubahan

dengan klik pada ikon Save current loaded library on disk pada toolbar bagian atas. Klik Yes jika ada pesan konfir-
masi yang muncul. Komponen skematik kita yang baru telah selesai dan telah tersedia pada library yang diindikasikan di
title bar window.

13. Sekarang Anda bisa menutup window Component Library Editor. Anda akan kembali ke window editor skematik. Kom-
ponen yang baru akan dapat diakses dari library myLib.

14. File library apapun file.lib akan dapat Anda gunakan dengan menambahkannya ke path library. Dari Eeschema, buka
Preferences→ Library dan tambahkan path ke dalam User defined search path serta file.lib ke dalam Component library
files.

6.2 Ekspor, Impor, dan Modifikasi Komponen Library

Terkadang kita tidak perlu membuat komponen dari awal, akan tetapi lebih mudah untuk mulai dari komponen yang sudah ada
dan memodifikasinya. Pada bagian ini, kita akan melihat bagaimana mengekspor sebuah komponen dari library standar KiCad
(device) ke library yang telah Anda buat (myOwnLib.lib) dan kemudian melakukan modifikasi.
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1. Dari KiCad, buka Eeschema, klik pada ikon Library Editor , klik pada ikon Select working library dan

pilih library device. Klik pada ikon Load component to edit from the current lib dan lakukan impor komponen
RELAY_2RT.

2. Klik pada ikon Export component , buka folder library/ dan simpan file library yang baru dengan nama myO-
wnLib.lib.

3. Anda bisa mengaktifkan library myOwnLib.lib agar bisa Anda gunakan, dengan menambahkannya ke path library. Dari
Eeschema, buka Preferences → Component Libraries dan tambahkan library/ ke dalam User defined search path dan
myOwnLib.lib ke dalam Component library files. Tutup window.

4. Klik pada ikon Select working library . Pada window Select Library, klik myOwnLib dan klik OK. Perhatikan bahwa
judul window mengindikasikan library yang sedang kita gunakan, yaitu myOwnLib.

5. Klik pada ikon Load component to edit from the current lib dan lakukan impor komponen RELAY_2RT.

6. Sekarang Anda bisa melakukan modifikasi komponen sesuai keinginan Anda. Arahkan mouse ke atas label RELAY_2RT,
tekan tombol e dan beri nama MY_RELAY_2RT.

7. Klik pada ikon Update current component in current library pada toolbar bagian atas. Simpan perubahan yang

Anda lakukan dengan klik ikon Save current loaded library on disk pada toolbar bagian atas.

6.3 Membuat Komponen Skematik dengan QuickLib

Bagian ini akan menjelaskan cara alternatif untuk membuat komponen skematik MYCONN3 (lihat MYCONN3 di atas) dengan
menggunakan peralatan quicklib yang berbasis Internet.

1. Bukalah halaman web quicklib: http://kicad.rohrbacher.net/quicklib.php

2. Isilah halaman tersebut dengan informasi berikut: Component name: MYCONN3 Reference Prefix: J Pin Layout Style:
SIL Pin Count, N: 3

3. Klik pada ikon Assign Pins. Isilah halaman dengan informasi berikut ini: Pin 1: VCC Pin 2: input Pin 3: GND. Type :
Passive untuk ketiga pin tersebut.

4. Klik pada ikon Preview it, dan jika telah sesuai dengan keinginan Anda, klik pada Build Library Component. Unduh file
hasilnya, dan ubah namanya menjadi tutorial1/library/myQuickLib.lib. Anda telah selesai!

5. Lihat hasilnya dengan menggunakan KiCad. Dari manajer proyek KiCad, buka Eeschema, klik pada ikon Library Editor

, klik pada ikon Import Component , buka tutorial1/library/ dan pilih myQuickLib.lib.

http://kicad.rohrbacher.net/quicklib.php


Mari Mengenal KiCad 36 / 42

6. Anda bisa menggunakan komponen dan keseluruhan library myQuickLib.lib dengan menambahkannya ke path library
KiCad. Dari Eeschema, buka Preferences→ Component Libraries dan tambahkan library ke dalam User defined search
path, serta myQuickLib.lib ke dalam Component library files.

Metode pembuatan komponen library ini akan sangat efektif jika Anda ingin membuat komponen dengan jumlah pin yang
banyak.

6.4 Membuat Komponen Skematik dengan Jumlah Pin yang Banyak

Pada bagian yang berjudul Membuat Komponen Skematik dengan QuickLib, kita melihat bagaimana membuat sebuah komponen
skematik dengan menggunakan peralatan berbasis web quicklib. Bagaimanapun, terkadang Anda perlu membuat komponen
skematik dengan jumlah pin yang banyak (hingga ratusan pin). Di KiCad, hal ini bukanlah hal yang rumit.

1. Misalkan Anda membutuhkan komponen skematik dengan pin berjumlah 50 buah. Praktik yang umum dilakukan adalah
membuat beberapa gambar dengan jumlah pin yang tidak terlalu banyak, sebagai contoh dua gambar yang masing-masing
memiliki 25 pin. Penggambaran komponen seperti ini akan memudahkan saat membuat koneksi pin.

2. Cara yang paling baik untuk membuat komponen kita adalah dengan menggunakan quicklib untuk membuat dua buah
komponen dengan jumlah pin sebanyak 25 buah, secara terpisah. Kemudian melakukan penomoran ulang pin-pin tersebut
dengan skrip Python, dan terakhir menggabungkan kedua komponen tersebut dengan menggunakan copy-paste untuk
menjadikan keduanya menyatu ke dalam satu komponen DEF dan ENDDEF.

3. Contoh skrip Python sederhana di bawah ini bisa digunakan dengan file in.txt dan out.txt untuk melakukan penomoran
ulang baris: X PIN1 1 -750 600 300 R 50 50 1 1 I menjadi X PIN26 26 -750 600 300 R 50 50
1 1 I hal ini dilakukan untuk semua baris pada file in.txt.

Skrip sederhana

#!/usr/bin/env python
’’’ simple script to manipulate KiCad component pins numbering’’’
import sys, re
try:

fin=open(sys.argv[1],’r’)
fout=open(sys.argv[2],’w’)

except:
print "oh, wrong use of this app, try:", sys.argv[0], "in.txt out.txt"
sys.exit()
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for ln in fin.readlines():
obj=re.search("(X PIN)(\d*)(\s)(\d*)(\s.*)",ln)

if obj:
num = int(obj.group(2))+25
ln=obj.group(1) + str(num) + obj.group(3) + str(num) + obj.group(5) +’\n’
fout.write(ln)

fin.close(); fout.close()
#
# for more info about regular expression syntax and KiCad component generation:
# http://gskinner.com/RegExr/
# http://kicad.rohrbacher.net/quicklib.php

1. Saat menggabungkan dua komponen menjadi satu, sangat penting untuk menggunakan Library Editor dari Eeschema untuk
memindahkan komponen yang pertama sehingga komponen yang kedua tidak berada di atas komponen pertama. Di bawah
ini, Anda akan menemukan file final.lib dan tampilannya di Eeschema.

Isi file *.lib

EESchema-LIBRARY Version 2.3
#encoding utf-8
# COMP
DEF COMP U 0 40 Y Y 1 F N
F0 "U" -1800 -100 50 H V C CNN
F1 "COMP" -1800 100 50 H V C CNN
DRAW
S -2250 -800 -1350 800 0 0 0 N
S -450 -800 450 800 0 0 0 N
X PIN1 1 -2550 600 300 R 50 50 1 1 I

...

X PIN49 49 750 -500 300 L 50 50 1 1 I
ENDDRAW
ENDDEF
#End Library



Mari Mengenal KiCad 38 / 42

1. Skrip Python yang ditampilkan di sini adalah sebuah alat yang sangat powerful untuk memanipulasi baik nomor pin
maupun label pin. Namun perlu diperhatikan bahwa kemampuan skrip ini didapatkan dari sintaks Regular Expression
yang rumit namun sangat berguna: http://gskinner.com/RegExr/.
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Bab 7

Membuat Footprint Komponen

Tidak seperti perangkat lunak EDA lainnya, yang memiliki satu tipe library yang berisi simbol skematik dan variasi footprint,
file .lib pada KiCad hanya berisi simbol skematik, sedangkan footprint disimpan pada file .kicad_mod. Cvpcb digunakan untuk
melakukan pemetaan footprint ke simbol.

Seperti halnya file .lib, file library .kicad_mod adalah file teks yang bisa berisi satu atau beberapa part.

KiCad telah menyediakan sejumlah library footprint, namun kadang kala Anda mungkin membutuhkan footprint yang tidak
tersedia di library KiCad. Berikut adalah langkah untuk membuat sebuah footprint PCB yang baru di KiCad:

7.1 Menggunakan Footprint Editor

1. Dari manajer proyek KiCad, buka Pcbnew. Klik pada ikon Open Footprint Editor pada toolbar bagian atas. Footp-
rint Editor akan terbuka.

2. Kita akan menyimpan footprint yang baru MYCONN3 ke dalam library footprint myfootprint. Buat sebuah folder myfo-
otprint.pretty di dalam folder proyek tutorial1/. Klik Preferences → Footprint Libraries Manager dan tekan tombol
Append Library. Pada tabel, masukkan "myfootprint" pada Nickname, masukkan "${KIPRJMOD}/myfootprint.pretty"
pada Library Path dan masukkan "KiCad" pada Plugin Type. Tekan OK untuk menutup window PCB Library Tables. Klik

pada ikon Select active library pada toolbar bagian atas. Pilih library myfootprint.

3. Klik pada ikon New Footprint pada toolbar bagian atas. Ketik MYCONN3 pada footprint name. Di tengah layar,
akan muncul label MYCONN3. Di bawah label, Anda akan menemukan label REF*. Klik kanan pada MYCONN3 dan
pindahkan ke atas REF*. Klik kanan pada REF*__, pilih Edit Text dan ganti namanya dengan SMD. Ubahlah nilai Display
menjadi Invisible.

4. Pilih ikon Add Pads pada toolbar sebelah kanan. Klik pada lembar kerja untuk meletakkan pad. Klik kanan pada
pad yang baru dibuat, dan klik Edit Pad. Anda juga bisa menggunakan tombol e.
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5. Ubah nilai Pad Num menjadi 1, Pad Shape bernilai Rect, Pad Type bernilai SMD, Shape Size X bernilai 0.4, dan Shape Size
Y bernilai 0.8. Klik OK. Klik lagi ikon Add Pads dan letakkan dua buah pad.

6. Jika Anda ingin mengubah ukuran grid, lakukan Klik kanan→ Grid Select. Pastikan untuk memilih ukuran grid yang
tepat sebelum meletakkan komponen.

7. Pindahkan label MYCONN3 dan label SMD ke luar sehingga tampak seperti gambar.

8. Saat meletakkan pad, terkadang kita perlu mengukur jarak relatif. Letakkan kursor di mana Anda ingin meletakkan titik
koordinat relatif (0,0), dan tekan tombol spasi. Saat menggeser kursor, Anda akan melihat indikasi relatif dari posisi kursor
pada bagian bawah halaman. Tekan tombol spasi untuk mengatur titik koordinat awal relatif yang baru.

9. Sekarang tambahkan kontur footprint. Klik pada tombol Add graphic line or polygon pada toolbar sebelah kanan.
Gambarlah garis luar konektor yang mengelilingi komponen.

10. Klik pada ikon Save Footprint in Active Library pada toolbar bagian atas, dan gunakan nama default MYCONN3.
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Bab 8

Catatan Tentang Portabilitas File Proyek KiCad

File apa saja yang perlu Anda kirimkan ke orang lain agar ia bisa membuka dan menggunakan proyek KiCad Anda?

Saat Anda memiliki sebuah proyek KiCad yang akan anda bagikan ke orang lain, Anda perlu memastikan bahwa file skematik
.sch, file papan PCB .kicad_pcb, file proyek .pro dan file netlist .net, dikirimkan bersama dengan file part skematik .lib dan file
footprint .kicad_mod. Hanya dengan cara ini, orang yang menerima file Anda akan bebas untuk memodifikasi skematik dan
papan PCB yang Anda buat.

Untuk file skematik KiCad, diperlukan adanya file .lib yang berisi simbol-simbol. File library tersebut harus dimuat pada pre-
ference Eeschema. Sedangkan untuk file papan PCB (file .kicad_pcb), footprint dapat disimpan di dalam file .kicad_pcb. Anda
bisa mengirimkan kepada orang lain sebuah file .kicad_pcb saja, dan ia akan bisa melihat dan mengedit papan PCB Anda. Ba-
gaimanapun, saat mereka ingin memuat komponen dari netlist, library footprint (file .kicad_mod) harus tersedia dan dimuat di
preference Pcbnew, seperti halnya skematik. Penting juga untuk memuat file .kicad_mod di preference Pcbnew agar footprint
dapat ditampilkan di Cvpcb.

Jika seseorang mengirimi Anda file .kicad_pcb, dan ada footprint pada file itu yang ingin Anda gunakan pada papan PCB
yang lain, Anda bisa membuka Footprint Editor, memuat footprint dari papan PCB yang sedang dibuka, dan menyimpan atau
mengekspor ke library footprint yang lain. Anda juga bisa mengekspor semua footprint dari file .kicad_pcb melalui Pcbnew
→ File→ Archive→ Footprints→ Create footprint archive, yang akan membuat file .kicad_mod yang baru dengan semua
footprint yang digunakan pada papan PCB.

Pada intinya, jika PCB adalah satu-satunya hal yang ingin Anda distribusikan, maka file .kicad_pcb saja sudah cukup. Namun,
jika Anda ingin memberikan kemampuan penuh kepada orang lain untuk menggunakan dan memodifikasi skematik, komponen
dan PCB Anda, sangat direkomendasikan untuk melakukan zip dan mengirimkan direktori proyek berikut ini:

tutorial1/
|-- tutorial1.pro
|-- tutorial1.sch
|-- tutorial1.kicad_pcb
|-- tutorial1.net
|-- library/
| |-- myLib.lib
| |-- myOwnLib.lib
| \-- myQuickLib.lib
|
|-- myfootprint.pretty/
| \-- MYCONN3.kicad_mod
|
\-- gerber/

|-- ...
\-- ...
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Lebih Lanjut Tentang Dokumentasi KiCad

Dokumen ini adalah panduan ringkas untuk sebagian besar fitur di KiCad. Untuk instruksi yang lebih detail, bacalah file help
yang bisa diakses melalui tiap-tiap modul KiCad. Klik Help→Manual.

KiCad telah menyertakan sejumlah manual dalam berbagai bahasa untuk keempat komponen perangkat lunak yang ada di KiCad.

Versi Bahasa Inggris dari buku manual KiCad didistribusikan bersama dengan perangkat lunak KiCad.

Sebagai tambahan bagi buku manual, KiCad didistribusikan dengan tutorial ini, yang telah diterjemahkan ke dalam berbagai
bahasa. Semua versi yang berbeda dari tutorial ini didistribusikan secara cuma-cuma dengan semua versi terbaru KiCad. Tutorial
ini, bersama dengan buku manual, telah disertakan bersama versi KiCad yang Anda gunakan.

Sebagai contoh, pada sistem operasi Linux, lokasi yang umum untuk menemukan dokumentasi KiCad adalah pada direktori
berikut, bergantung pada distribusi yang Anda gunakan:

/usr/share/doc/kicad/help/en/
/usr/local/share/doc/kicad/help/en

Pada sistem operasi Windows, Anda bisa menemukannya di:

<installation directory>/share/doc/kicad/help/en

Pada OS X:

/Library/Application Support/kicad/help/en

9.1 Dokumentasi KiCad di Web

Dokumentasi KiCad yang terbaru tersedia dalam berbagai bahasa di Web.

http://kicad.org/help/documentation/

http://kicad.org/help/documentation/
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